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general. Barbara always treated us fairly and recog-
nized our individual needs. We all gained from her 
hard work. Barbara and her daughter moved to up- 
state New York and is presently teaching at Burger 
Middle School in West Henrietta, New York. Her 
daughter Jessica is a student at RIT.

After word of my recognition got out to the 
LMS community, I received many mentions of 
congratulations from teachers and students at 
LMS. Your thoughtfulness is so appreciated. 
Thank you all for the nice words.
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Since my last newsletter, I’ve had some very 
busy but exciting events in my life. Being busy ex-
plains the reason for the late newsletter. Soon I 
hope to get the newsletter back on a beginning of 
the month schedule.

As I mentioned, I’ve been very busy. David and 
I were out of the building for 7 days as we worked 
on our certification with Apple Computer. We are 
now Apple Certified Desktop and Portable Tech-
nicians. Earning this status was not easy as it re-
quired extensive study and the passing of three 
rather difficult exams. As part of our training, we 
had to dismantle and reassemble several Apple 
desktop and laptop computers. Scary? It was 
scary the first time; however, under the knowl-
edgeable guidance of Ben Samms from Apple To-
ronto, we put the iBook back together and it 
worked fine. We did the procedure to a couple of 
other iBooks for practice. 

We’re now confident with our new abilities. 
David and I are now ready to take on any Apple 
iBook! It’s not a scary task anymore. Our hopes 
are to be able to do in-house repairs on Apple 
computers that are out of warranty. In-house re-
pairs would not only save money but could cut 
down on the turn around time of getting iBooks 
back in the hands of our students.

As you probably heard, I was selected as a run-
ner up for Technology Teacher of the Year by the 
Association of Computer Technology Educators 
of Maine. I received my award on October 15th at 
the ACTEM conference held at the Augusta Civic 
Center. I was presented with a framed certificate 
and a check for $500.

Being presented with this award was very excit-
ing indeed. After teaching for nearly 27 years, it is 
such an honor to be recognized in this way. I was 
nominated by my former team leader, Barbara 
Mathieu. Barbara was an outstanding educator at 
LMS and a superb team leader that always pro-
moted her teachers and the Unified Arts in

Another Busy Month at LMS

Kidding? No, I’m not! This past month, I held 
five Technology Clinics that dealt with the con-
struction of classroom web sites. Forty-two teach-
ers took part in these clinics which were designed 
to give teachers the basics of constructing a web 
site. Will all of these teachers actually have a web 
site for their classrooms? In time, I believe so. I’ve 
seen several web sites up and running already. 

As the year goes on, David and I are planning 
on continuing clinics dedicated to the Hyper Text 
Markup Language (HTML). Our next HTML 
clinic will show participants a few more advanced 
tricks with time set aside for teachers to continue 
work on their sites with our guidance. 

Why are teachers so interested? The biggest ad-
vantage of having a classroom web site is the abil-
ity to upload worksheets for students to down-
load. A web site is also a great way to set up links 
that you want your students to use within your 
classroom. The neatest thing is that students that 
are homesick or on vacation anywhere in the world 
can keep in touch with what is going on at school. 

Classroom Web Site? You’re kidding!

LMS
Worldwide
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Hey

Ran
dy

!
How do you: jump from one column to another?

Actually it’s easy... if you know the trick. We 
will begin by learning how to make columns.

Step 1 - Begin by opening up a new AppleWorks word processing document.

LMS and a superb team leader that always pro-
moted her teachers and the Unified Arts in

.

Step 2 - At the top of word processing documents, you will see an icon that represents columns. I’ve shown 
this icon with it’s two buttons below.

More columns button

Less columns button

This shows the columns icon.

Step 3 - By clicking on the “more” columns button, you can have up to nine columns. If you make more col-
umns than you really need, you can decrease the number of columns by clicking the “less” columns button. As 
you can see below, I made three columns.

Step 4 - As explained above, you jump from column to column by pressing on the “enter” key. Not the return 
key. The “enter” key is located to the right of the space bar. Once you have written something in each column, 
you simply jump from column to column by clicking on the column you want to work in with your mouse.

Step 5 - Finally, if you are working in column three and would like to continue with columns on the next page 
down, just press on the “enter” key.
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Hey

Ran
dy

!
How do you: format a document to have columns at 
the top, no column in the middle of the document, and then 
columns at the bottom?

Actually it’s easy... if you know the trick. We 
will start off by making a word processing document with 
three columns.

Step 1 - As I explained on page two of this newsletter, make a three-column document like the one shown be-
low.

Step 2 - The next step is to click after the last item in column 3 (Chocolate Chip Cookies) and then hit return.

Step 3 - Now go to the Format menu and drag down to Insert Section Break. Once the section break is in place, 
you can type whatever you like. Note: If you used Label Styles like I did above for my listings, make sure 
that you choose none before making the section break.

Step 4 - As I explained in the above paragraph, I simply made another section break and added three more col-
umns.
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David and I were very pleased to see how many 
LMS teachers took advantage of our first five Tech-
nology Clinic sessions. As was stated earlier in this 
newsletter, over 40 teachers participated. At this 
time, I would like to recognize and thank the fol-
lowing teachers for their time and dedication for im-
proving their computer skills: Sue Grondin, Loretta 
Hamann, Lil Castonguay, Pat Langelier, Elisa Whit-
tier, Kim Russell, Kay Allison, Deanna Marken, 
Brent Watson, Phil Brookhouse, Sue Reny, Jim 
Dobson, Christine Cook, Cassandra Young, Diane 
Bleakney, Nicole Goyette, Kelly Brown, Judy 
Howard, Marcia Potter, Beth Woodhead, Pat Har-
ris, Howard Ellis, Katherine Cargile, Nicole Pendex-
ter, David LeGloahec, Christine Poulin, Nat Scrib-
ner, Mike Courchesne, Shayna Malyata, Megan 
Cassada, Rona Boilard, Judy Drummond, Claire 
Gamache, Pam Brown, Jen Laroche-Albert, 
Dwayne Conway, Lyndsay Rae Delorme, Todd 
Mogul, Annette Caldwell, Susan Weber, Billie Jo 
Brito, and Celise Murphy.

As always, if you need extra help after a clinic, 
just ask. David and I are willing to help. Don’t be 
afraid to ask. We want to see you succeed.

When I wrote last month's newsletter, I wasn’t 
sure how I would “recruit” teachers for the upcom-
ing Technology Clinics. I did know that we learned 
from last summer’s technology sessions that 10 
participants at a time was the only way to provide 
quality instruction. Keeping that in mind, instead of 
sending out sign-up sheets, I went around the 
school and personally invited teachers to attend. I 
began by inviting individual teams; however, I 
found that I had better luck by taking the first 10 
teachers that were interested in attending. Since I 
offer the same clinic up to five times, my system 
seems to be fair and caters to the schedule of more 
teachers.

Since my first five clinics dealt with the posting 
of homework assignments on a web site, it wasn’t 
an appropriate clinic for Ed Techs. Thus, only lead 
lead teachers were invited. My next clinic, on
Tuesday, October 26, will deal with the use of  
AppleWorks’ “Slide Show” and “Presentation.” 
These two applications are Apple's answer to
Microsoft’s “Power Point.” This clinic is already
full with ten participants. I will be offering this 
clinic possibly later in the week to ten more
participants, and Ed Techs will be invited too. 
I will be offer this clinic as long as there are 
participants interested in attending. 

My “Slide Show” and “Presentation” clinics are 
designed for participants that haven’t attended the 
summer technology clinic. However, if you truly 
need a refresher, you are welcome to join. When I 
go out recruiting for participants I will explain ex-
actly what we will be covering during the clinic. If 
this is something that is of interest to you, let me 
know and I’ll come to you first. You may need to 
keep reminding me though!

Wow! 42 Teachers Attended

Earlier this month, I began recruiting students to 
join our iTeam. This year’s school wide iTeam is 
going to be made up of a few very select students. 
Training will take place as I bring students on to the 
team. The major role of this year’s iTeam is to per-
form triage work in the library during morning 
homeroom.

Many of the problems that arise are due to op-
erator inexperience. The iTeam is there to solve 
these small problems so that students don’t have to 
go without a laptop. If a laptop really does have a 
serious problem, the iTeam members will recognize 
the problem and forward the problem already diag-
nosed to Mr. Plourde. Their work is a time saver 
for Mr. Plourde and keeps as many iBooks in the 
hands of students as possible.

Right now we have two 8th grade boys manning 
the iTeam Triage table. An 8th grade girl is expected 
to join the first week of November. 

iTeam AM Laptop Triage

Upcoming Technology Clinics

Signed Up at Shaw’s Yet?

Specify LMS as your designated school and 
our school will receive a nice check from 

Shaw’s. It’s painless and doesn’t cost you 
anything but your time to sign up.
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Hey

Ran
dy

!
How do you: make the buttons on the AppleWorks 
Button Bar bigger?

Actually it’s easy... if you know the trick. 

Step 1 - First you need to know what the Button Bar is. Below I’m showing you the button bar as it ap-
pears with its default settings.

Step 2 - There is a good chance that you might not see the Button Bar. If that’s the case, go up to the Win-
dow menu and drag down to Show Button Bar. Likewise if the Button Bar is something that annoys you, 
you can remove it by going to the Window menu and dragging down to Hide Button Bar. But for this exam-
ple, let's make believe that you aren’t hiding it.

Step 3 - To increase the size of the Button Bar buttons, simply go to the AppleWorks menu and drag 
down to Preferences and then drag to the right to select Button Bar. A window like the one below will ap-
pear.

Step 4 - Change the Button Style from 
Small to Large by clicking on the drop-
down menu shown here. Now click o 
the Done button.

Step 5 - This is what the Button Bar will look like once you have increased its size. Below, I’m only show-
ing a small section of the Button Bar.

This is great modification for 
students that have a hard 
time seeing.
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Hey

Ran
dy

!
How do you: find royalty free images that students 
can use without getting blocked out by our filtering system?

Actually it’s easy... if you know the trick or 
should I say, the web site address!

www.pics4learning.com
Step 1 - All the pictures found at www.pics4learning are royalty free for educational uses. This means that 
you can use them on just about anything including your web site. Simply go to the site. Pick a category or do 
a search. Chances are that you will find the picture that you are looking for. 

Step 2 - Once you find the picture that you like, click on its thumbnail so that you can get a full size pic-
ture.

Step 3 - Hold down on the ctrl key while clicking on the image. Drag down to download to disk and you 
now have the image on your desktop.

Step 5 - Go to the File menu and then drag down to insert. Change file format to all available and the pic-
ture is now on your document. (By the way, there are other ways of doing this too!) With the picture se-
lected, go to the arrange menu and select Scale By Percent. Doing this will allow you to change the size of 
your picture.

Step 4 - With your AppleWorks tool panel showing, click on the arrow pointer so that it’s selected.

Step 6 - Give credit to the person that donated the picture 
and then consider donating your pictures to the site for other 
teachers and students to use.

http://www.pics4learning.com/
http://www.pics4learning.com/
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